
Previous features and fixed issues
This build includes many fixed issues, including the following updates from previous releases.

SQL Diagnostic Manager provides the following new features and fixed issues.

10.1.1 New features

SQL Diagnostic Manager allows you to launch SQL Workload Analysis in context of your monitored server from the desktop console and the IDERA 
Dashboard. For more information, see Launch SQL Workload Analysis

10.1.1 Fixed issues

Reports

The Transaction Log Statistics report is no longer showing erroneous used size values.

The Disk Space History report is no longer encountering the 'String or binary data would be truncated' error.

Query Monitor

Query Monitor is no longer reporting a captured stored procedure as both a SQL Batch and a Stored Procedure when Query Monitor is configured to 
collect queries using Extended Events.

Query monitor is no longer capturing queries that do not meet threshold definitions.

Procedure Cache

SQLDM is no longer having issues when accessing to the Procedure Cache tab.

SQL Server CPU Usage (Percent)

SQLDM is no longer reported inflated values for the SQL Server CPU Usage (Percent) metric on monitored instances running on systems with hyper-
threaded CPU.

Server Log file

The IDERA Dashboard is no longer recording the user login and password in the server.log file.

Cloud instances 

SQLDM is no longer encountering the 'Read login mode failed:System.IndexOutOfRangeException: Index was outside the bounds of the array' error while 
attempting to retrieve live data from a monitored instance running on Amazon EC2.

Blocked Sessions Graphs

The Blocked Sessions graphs report correctly the number of deadlocks that were detected by SQLDM.

Prescriptive Analysis

The Prescriptive Analysis is no longer encountering the ‘ ’ error while saving the collected data into the SQLDM Error converting data type nvarchar to float
repository database.

Grooming 

SQLDM  is now grooming the DatabseFileStatistics table in the SQLDM repository database.

Alerts

The Alerts pane is no longer having issues loading any active alerts due to a timeout with the query being issued against the SQLDM repository database. 
This query has been optimized to retrieve the list of active alerts in a timely manner.

10.1 New features

Health Index Calculation
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Modify the index calculation scale factor for each type of alert. Assign instances more or less importance in the overall heatmap ranking by modifying their 
scale factors. For additional information, see .Heatmap Calculation Configuration

Use Instance Friendly Name in Web Console

The Friendly Name assigned in the Desktop Console can also be used in the Web Console. For more information, see Assign a friendly name to your SQL 
.Server instance

Query Waits Alert Response Action

Collect more information by enabling the collection of Query Waits when the criteria for an alert response rule is met. For additional information, see Query 
.Waits Action Provider

SCOM Alert Response Action
Send an Event or an Alert to SCOM in response to an alert when the criteria for the new alert rule is met. For additional information, go to SCOM Event 

 and  .Action Provider SCOM Alert Action Provider

PowerShell Alert Response Action 

Specify a PowerShell script to run in response to an alert when the criteria for the new alert rule is met. For additional information, see PowerShell Action 
.Provider

PowerShell Snap-in Added Functions

Customize your monitored SQL Server properties with new cmdlets. For more information, see Customize your Monitored SQL Server properties within 
.PowerShell

Independent Scheduling of Multiple Baselines

Add and schedule multiple baseline periods in addition to the default baseline. For additional information, see .Schedule multiple baselines

10.1 Fixed issues

General

The SQLDM Desktop is no longer showing slow performance that was caused by retained data from deleted instances.

Grooming process

The grooming process has stopped the exceeding growth of the SQLStatementsOverflow table.

Monitor AlwaysOn Availability Groups

The monitored Availability Group Listeners no longer have issues gathering information from the primary replica.

The “Unreadable availability replica” status is no longer displaying in the databases that are part of AlwaysOn Availability Groups.

Collection service

Enabling maintenance mode for all monitored instances is no longer causing SQLDM Collection Service crash.

Troubleshoot WMI connectivity issues

After troubleshooting the WMI connectivity issues the “WMI is not available on the server” alert is no longer displayin

10.0.2 New features

 There are no new features.

10.0.2 Fixed issues

General

The "DtcService Status" error displayed after selecting a view or tag in the desktop client, when configured with the Hungarian system language, 
no longer occurs.
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An issue preventing SQL Diagnostic Manager from registering instances using long and complex SQL Authentication passwords no longer occurs.
The Snapshot Selection window now displays correctly the AM and PM time symbols when using French (Swiss) regional settings in SQL 
Diagnostic Manager.
The SQL Server 2012 and SQL Server 2008 versions are now displayed correctly in SQL Diagnostic Manager.
An issue preventing SNMP Traps to work properly no longer occurs

Report

An issue preventing the Top Queries report from displaying accurate results is fixed.
There are no longer any issues preventing the Top Servers report from rendering properly or deploying into a Microsoft Reporting Services Server.
A data type conversion error no longer occurs when running the Top Queries report in SQL Diagnostic Manager.

Query waits

An issue preventing Query Waits from being retrieved historically no longer occurs.

Query Monitor 

An issue causing Query Monitor to be disabled after Maintenance Mode no longer occurs.

Alerts

There are no longer any issues preventing alert templates from being edited after making changes in the "Days since last backup" metric 
configuration.
There are no longer any issues causing operational query monitor alerts to be triggered repeatedly due to an XML parsing error in SQL 
Diagnostic Manager.
The Days since last backup alert now works seamlessly in an availability group environment.
The Days since last back up alert is no longer triggered for database snapshots.
The Days since last back up alert is no longer triggered for mirrored databases.
There are no longer any issues preventing alerts from being triggered properly in the desktop console after upgrading SQL Diagnostic Manager.
The details section of the Alerts view now displays the full list of recorded error log messages for SQL Server Error Log alerts. 

Tables & Indexes view

There are no longer any issues causing data to populate slowly and timeout messages when accessing the Tables & Indexes view.

Custom Counters

Monitored SQL Server instances now remain linked to custom counters when setting maintenance mode with PowerShell.

10.0.1 New features 

There are no new features.

10.0.1 Fixed issues

General

The desktop client is no longer unresponsive when the registered instances are unable to connect.

Blocking Sessions view

The bottom chart of the Blocking Sessions view is now displaying a correct blocking session count.  

Reports

There are no longer any issues preventing the Top Servers report from rendering properly or deploying into a Microsoft Reporting Services Server. 

10.0 New features

Prescriptive analysis

Run or schedule a prescriptive analysis or workload analysis on a specific SQL Server instance to identify and resolve common areas of SQL Server 
performance problems such as queries, database objects, and more. The analysis results in useful configuration and tuning recommendations that you can 
apply. For additional information, see .Analyze your SQL Server instance
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Multiple baselines

 Define and schedule any number of baseline periods.  View relevant baseline in effect in various metric graphs plus enable alerting and recommendations
to review thresholds. For additional information, see Configure server baseline options 

Multiple SQL Diagnostic Manager custom dashboards

Graphically create multiple custom dashboards by dragging-and-dropping widgets.   Easily control time range across widgets, add, edit, duplicate, and
remove dashboards.  Use your multiple dashboards to compare metrics across your monitored instances.  For additional information, see Create custom

 dashboards

Import/Export alert response 

In SQL Diagnostic Manager 10.0 you can select alert responses to import or export . For additional information, see     Configure how SQL Diagnostic 
. Manager responds to alerts

Import/Export wizard

The Import/Export wizard centralizes all SQL Diagnostic Manager import and export capability for customization. In one stop import or export all your alert 
responses, alert templates, custom counters, and custom reports. For additional information, see Use the SQL Diagnostic Manager Import/Export wizard

Top Servers report

Generate a report on a specific metric (e.g. CPU utilization) and clearly view the top 10 servers with the highest threshold over a given timeframe. For 
additional information, see .Top servers custom report

Self-service licensing model 

In SQL Diagnostic Manager 10.0 you can login to the  or launch the license manager utility to generate your own license keys. ForIdera Customer Portal
additional information, see . Generate a new license key

Web console improvements

Federated Overview screens

Access aggregated views and functions for all your SQL   Repositories connected to the IDERA Dashboard. Filter results by tags, aDiagnostic Manager
specific SQL   Repository, a specific SQL Server Major version, or an instance name through wildcard characters.   For additionalDiagnostic Manager
information, see .  Navigate the web console dashboard

New common Dashboard widgets

Use any of the eighteen Top X widgets available for customization in the Overview tab or the Details view of the IDERA Dashboard. For more information
on this feature, see Navigate the IDERA Dashboard 

New color-coded Alerts Timeline view

Easily identify the highest alert for your monitored instance at any point in the time and the highest alert for a specific category.  Select a default time range
or a customized one, filter timeline results by category and display order.  For more information on this feature, see .View your SQL Server alerts  

Query Waits view enhancements

Re-designed Query Waits by Time and Query Waits by Duration views. New Wait Category dimension to display, selectable time range, and improved
navigation from one view to another.  For more information, see . View your SQL Server query waits information

Databases Summary view enhancements 

Select multiple databases to display as horizontal stacked bar charts. For more information, see . View your SQL Server databases information

Collapsible side panel

Hide or expand the side panels of the SQL Diagnostic Manager Overview view.  For more information, see .Navigate the web console dashboard

 

10.0 Fixed issues 

General

This release fixes an issue with unsigned executables that occasionally blocked upgrades or resulted in security concerns that files may be 
 corrupted.  In SQL Diagnostic Manager 10.0 executable binary files are digitally signed.   
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Web console

An issue preventing the Databases view of the  web console from populating when a database is offline no longer occurs. 

Newsfeed

An issue preventing users from creating a Newsfeed user account no longer occurs.

9.1.2 New features

There are no new features.

9.1.2 Fixed issues 

General

An issue causing a management service memory leak no longer occurs.

IDERA Dashboard

 A registration issue causing the web console and IDERA Dashboard to display blank no longer occurs.

Disk view

 An issue preventing the Disk Busy Total or Disk Busy Per Disk graphs from displaying data no longer occurs .

 9.1.1 New features 

There are no new features. 

9.1.1 Fixed issues 

General

An issue preventing OS metric statistics from being collected and disk drives not to be discovered after upgrading to 9.1, no longer occurs.

Single instance dashboard 

This release fixes an issue that prevented the databases tab of the single instance dashboard from populating when a database was set offline.

Deadlocks

An issue causing deadlocks in the SQL   Repository database after upgrading to SQL   9.1, no longerDiagnostic Manager Diagnostic Manager
occurs.

Mount Point 

An issue preventing filegroup statistics to be saved to the SQL   Repository, no longer occurs. This issue was specific toDiagnostic Manager
filegroups aiming at Mount Point drives.

Alerts

An issue causing the Filegroup Space Full (percent) alert to trigger with higher than normal percentage values after upgrading to SQL Diagnostic
 9.1, no longer occurs.Manager

Hyper-V

A permissions issue preventing the Hyper-V server from collecting data and displaying the same, no longer occurs. Note that SQL Diagnostic
 uses the direct WMI credentials established by the user under  to obtain data for the Hyper-V host. To gatherManager OS Metrics > Properties

VM metrics SQL   uses the VM credentials assigned by the user under .Diagnostic Manager Tools > VM Configuration

9.1 New features



Web console improvements 

Aggregated views across multiple SQL Diagnostic Manager repositories  

SQL   users are now able to access aggregated views and functions for all their SQL   Repositories connected toDiagnostic Manager Diagnostic Manager
the IDERA Dashboard. For example, the option to filter results by a specific SQL  Repository are included.Diagnostic Manager  For additional information,

 see .Navigate the IDERA Dashboard

Launch the SQL Diagnostic Manager Console from various views  

In SQL   9.1 users can launch the SQL   Console from the Thumbnail and Heatmap views, as well as from theDiagnostic Manager Diagnostic Manager
Alerts Detail screen. Upon clicking the SQL   iconDiagnostic Manager   blocked URL , users are directed to the associated instance. In addition, users can

 navigate back to the Overview tab of a specific single instance dashboard from the SQL   Console.Diagnostic Manager

Adjustable panels in key web console views  

The panels in the list, thumbnail, and heatmap sub-views of the SQL   web console are now adjustable, allowing users to expandDiagnostic Manager
panels to fit the page or to return to previous setting.

Improved thumbnail sub-view  

The thumbnail sub-view provides you with a graphical replication of your monitored SQL servers. The thumbnail sub-view is now sorted by criticality of
 worst alert and it includes sparkline graphs for a 1-hour view so that users can obtain an overview of key metrics CPU, Memory, I/O, and Response Time

quickly. For additional information, see .Use sub-views to identify and diagnose issues

Improved heatmap sub-view  

The heatmap sub-view provides you with a visual overall status of your SQL Server environment in the form of a grid of color coded squares that contain a 
. Through its color scheme and health index, you can easily identify which of your monitored instances need the most attention. Each squarehealth index

in the heatmap sub-view represents a monitored instance. For additional information, see .Use sub-views to identify and diagnose issues

 New web console widgets  

SQL   9.1 contains several new widgets for practical access to specific information in both the IDERA Dashboard and the web console:Diagnostic Manager

. Overall statusOverview tab widgets     , Instance status , Instance list , and Active alerts list.  
. Top instances by alert count, Top databases by alert counts, Top instances by CPU usage, and Alert counts by Details view tab widgets

category.
.  and . Resources tab widgets Top sessions by active CPU Top sessions by I/O activity

 Monitoring of non-query activities with Extended Events  

In SQL   9.1 collection of non-query events data such as deadlocks, Autogrow, and blocking is performed through Extended Events byDiagnostic Manager
default for SQL Server instances running SQL Server 2012+. First introduced in SQL Server 2008, Extended Events provide a new mechanism to capture
information about events inside the Database Engine and diagnose performance problems. This functionality is highly efficient and lightweight, resulting in
minimum impact on your SQL Server performance. For additional information, see .Set activity monitor options

 Integration with the IDERA community site  

SQL   9.1 allows users to share product contentDiagnostic Manager  , saving valuable resources. With these new features you can import and export
 ,    custom counters, custom reports and alert templates. For additional information, see Use custom counters to track metrics Custom reports , and Configure

.alert templates

Filegroup and Mount Point monitoring improvements

Configurable database filegroup alerts are now available

The  and the  alerts allow users to track available space at the filegroup level.Filegroup Space Full (Percent) Filegroup Space Full (Size)

 New Disk Size view  

The new Disk Size view in the Resources tab allows users to view key statistics on all monitored disk drives, including mount point drives, in their
environment. To access this new view, users can select an appropriate SQL Server instance, and then click in the  group of the Disk Size Views Resources
tab. For more information on this feature, see .Get disk size details

Disk Space Usage report available in SQL   Diagnostic Manager

The Disk Space Usage report provides users with the most recent snapshot of available disk space in their environment. To access this report, users can
go to  in the Navigation pane and select   in the Analyze menu. For more information on this report, seeReports Resources > Disk Space Usage  Disk

.Space Usage

Disk Space History report available in SQL   Diagnostic Manager
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The Disk Space History report provides an overview on available disk space with an emphasis on the historic level of activity for a specific disk. To access
this report, users can go to  in the Navigation pane and select   in the Analyze menu. For more information, seeReports Resources > Disk Space History  

.Disk Space History

Monitoring of additional SQL Server services

 SQL Server Active Directory Helper Status  

SQL   users are now able to monitor the status of the SQL Server Active Directory Helper service. For more information on this newDiagnostic Manager
alert, see .SQL Server Active Directory Helper Service Status alert

 SQL Server Browser Service Status  

SQL   users are now able to monitor the status of the SQL Server Browser service. For more information on this new alert, seeDiagnostic Manager  SQL
.Server Browser Service Status alert

 Server Summary report supports new SQL Server monitored services  

The Server Summary report now also displays the current status of the SQL Server Active Directory Helper service and the SQL Server Browser service.
For additional information, see .Server Summary

 9.1 Fixed issues

Installation

This release fixes a Windows 7 compatibility mode issue that prevented users from installing SQL   past the selection of aDiagnostic Manager
SQL Server instance to use for the Repository Database. An upgrade to InstallShield solved this issue.

Web console

An issue preventing the SQL   web console from displaying, no longer occurs with the full integration to the IDERA Dashboard.Diagnostic Manager

Query views

An issue in the Query views of the single instance dashboard, causing data to populate slowly and timeout messages, no longer occurs.

Query waits view

An arithmetic overflow error causing the Query Waits view of the SQL   Management console to display an empty pane, noDiagnostic Manager
longer occurs.

Alerts

This release fixes an issue that caused fragmentation alerts to trigger without updating the latest value returned in the Databases > Table &
 view, resulting in false alerts.Indexes

An issue preventing users from receiving critical Database Full (Percent) alerts no longer occurs.
This release fixes an issue where SQL   triggered a false unable to monitor SQL Server status alert when an invalid orDiagnostic Manager
nonexistent SPID was found during collection.
This release fixes an issue where SQL   triggered false critical Database Full (Percent) alerts for several servers when theDiagnostic Manager
actual values were much lower and did not require an alert notification.

Maintenance mode

This release fixes an issue in the SQL   web console, where servers displayed incorrectly as in maintenance mode even whenDiagnostic Manager
maintenance mode was not enabled or scheduled.

SCOM Management pack

An issue in the SCOM Management pack, preventing users from discovering the SQL   Repository when it containedDiagnostic Manager
unexpected NULL values, no longer occurs.

WMI

An issue causing RPC errors on servers with FQDN and the WMI collection method enabled, no longer occurs.

9.0 New features

http://wiki.idera.com/x/6QKfAg
http://wiki.idera.com/x/_QKfAg
http://wiki.idera.com/x/-AKfAg
http://wiki.idera.com/x/-AKfAg
http://wiki.idera.com/x/zQA1


Integration with the IDERA Dashboard

SQL   9.0 now integrates with the IDERA Dashboard, a common technology framework, designed to support the IDERA product suite.Diagnostic Manager
Users are able to obtain an overview of the status of their SQL Servers and hosted databases all in a consolidated view and navigate to individual product
dashboards for details. The IDERA Dashboard provides a central set of services for managing users, product registry, instance registry, aggregated alerts
across IDERA applications, a central web server, and tags for grouping instances. For additional information, see .Navigate the IDERA Dashboard  

New advanced query views

SQL   9.0 takes SQL Diagnostic Manager’s capabilities around query monitoring and diagnostics to the next level with a new MainDiagnostic Manager
Query view along with two low-level views (Query Signature and Query Details views).  Users are now able to explore query data in multiple ways and
easily get a handle of query performance in their environment. In SQL   9.0 query monitoring is enabled by default for SQL ServerDiagnostic Manager
instances running SQL Server 2008+, and collection is performed through Extended Events which has minimum impact on your SQL Server
performance.  Improved query monitoring allows for capturing of Query Execution Plans and provides graphical representations of the same in the Plan
Diagram of the Query Details view.  In addition, you can view the actual XML, SQL Text, and referenced columns of a query execution plan. For additional
information, see .View your SQL Server queries information

 Improved and integrated SQL Diagnostic Manager web console

SQL   9.0 provides a fully functional web console that integrates seamlessly with the IDERA Dashboard (common technologyDiagnostic Manager
framework) and is easy to access from any connected browser.  The SQL   web console provides the overall status of a SQL ServerDiagnostic Manager
environment to help diagnose any issues.  Users can quickly view the status of a single instance or instance groups, view all active alerts in their SQL
Server environment and drill down for details, or select different sub-views to diagnose performance issues faster, and view top values for selected
metrics. In addition, users are able to access the new advanced query views (see above) only from the SQL   web console and notDiagnostic Manager
from the SQL   desktop client console. For additional information, seeDiagnostic Manager  .Navigate the web console dashboard  

Licensing and version upgrading –

 Upgrade to SQL Diagnostic Manager 9.0

Customers upgrading from previous SQL   versions to SQL   9.0 need a new license key or it is not possible toDiagnostic Manager Diagnostic Manager
continue with the upgrade process.  Users can access the IDERA Customer Portal at the moment of upgrade from the license management window in
SQL   (Help > Manage Licenses) or directly atDiagnostic Manager  . https://idera.secure.force.com Information necessary to generate a new license key is
provided in the license management screen or the portal.

Help documentation –

SQL   Help (User Guide and Release Notes) is now wiki-hosted and available atDiagnostic Manager  .wiki.idera.com > SQL Diagnostic Manager  

9.0 Fixed issues 

Query Monitor

An issue preventing users from enabling the Query Monitor in monitored SQL Server 2000 instances no longer occurs.

Queries

An issue in the Queries tab and corresponding Statement mode, Signature mode and query history views, causing queries exported into Excel to
truncate, no longer occurs.

Alerts

This release fixes an issue that prevented users from knowing when Repository grooming had timed out.  SQL   9.0 includes aDiagnostic Manager
  new alert SQLdm Repository Grooming Time out that notifies users when SQL   no longer deletes stored metrics in theDiagnostic Manager

Repository at the set schedule.  To configure this alert access the Alert Configuration window.

Reports

  An issue preventing users from running the Disk Details report of the Resources analysis reports no longer occurs.

8.6 New features

Full support for SQL Server Express instances

SQL   8.6 fully supports monitoring of SQL Server Express instances. The following editions are supported: SQL Server 2005 Express,Diagnostic Manager
2008, 2008 R2, 2012, and 2014.
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Reporting on Query Wait Statistics

You can now run the Query Wait Statistics report to quickly analyze different wait type categories on your SQL Server and identify where your biggest
bottlenecks are occurring impacting your performance. For additional information about the new Query Waits Statistics report, see Query Waits Statistics

.report

Query Waits information is now extended to the Top Servers and Top Databases reports

SQL   has extended Query Waits information to the Top Servers and Top Databases report, providing users insight into the queries onDiagnostic Manager
your SQL Server instance that exceed a specific wait threshold. Users can now view information on Top Servers by wait time and Top Databases by wait
time. For additional information, see   .Top Servers and Top Databases

New database alert for Availability Group Preferred Replica

SQL   triggers anDiagnostic Manager   Availability Group Preferred Replica whenever the primary role changes to a different replica and is unavailable for a
.defined amount of time in minutes

8.6 Fixed Issues

Upgrade

Users upgrading from SQL Diagnostic Manager 8.5 to 8.6 may encounter a message (see image below) that requests closing the Java framework
application to proceed with the upgrade process. This framework is in use by the SQLdm WebUI Service of our web console feature. Clicking Igno

 allows the upgrade installation process to complete successfully. You can also stop the SQLdm WebUI Service manually and click  tore Retry
proceed with the Upgrade Wizard.

blocked URL

General

This release fixes an issue where scheduled SQL   Repository grooming failed.Diagnostic Manager
This release fixes an issue that prevented data from being returned on a SQL 2012 instance when selecting the option Use Extended Events

 in the Wait Monitoring tab of the Monitored SQL Server Properties window.(SQL2012 + only)

Views

An issue causing  and  values in the  view to vary from the real server valuesData File Spaced Used Log File Space Used Overview > Details
no longer occurs.
This release fixes an issue where the number of sessions displayed in the  view, after applying the Sessions > Details Affecting Tempdb only
filter, does not match the number of sessions in the  view.Databases >Tempdb Summary
An issue preventing disk drive statistics to return in the Disk view of the Resources tab no longer occurs.
This release fixes an issue that caused the Query waits and Query History views to lag displaying data when the frequency of how often the
console refreshes data was modified in the  window.Tools > Console Options
SQL  is designed to return the information that you want to view in the Signature Mode, Statement Mode, and Query HistoryDiagnostic Manager
views through filters. However, the filter  that excludes data returned with null values is not applicable to theExclude Currently Running Queries
Query History view and is now disabled by default.

Alerts

An issue issue causing OS Disk Full (Percent) alerts to trigger for disk drives previously excluded from alerting in the Alert Filters tab of the
Advanced Configuration window no longer occurs.
This release fixes an issue impeding the Deadlock Sessions report with detailed deadlock information to display when right-clicking (Show
Deadlock Details) or double-clicking over a deadlock alert in the Alerts view. Note that after upgrading to our latest version it is not possible to
view deadlock details for alerts generated in SQL   8.5 since this issue prevented deadlock information from being stored.Diagnostic Manager
This release fixes an issue impeding the Blocking Sessions report with detailed blocking and blocked sessions’ information to display when right-
clicking (Show Block Details) in the Alerts view, double-clicking over a Block report in the Blocking view, or clicking the Show Block Details link in
the Details section of the Alert view. Note that after upgrading to our latest version it is not possible to view block details for alerts generated in
SQL   8.5 since this issue prevented block information from being stored.Diagnostic Manager
An issue impeding new custom counters to be added in the Administration tab is solved.

Console

This release fixes an issue present after upgrading to SQL   8.5 with custom counters that had customized categories. ThisDiagnostic Manager
issue caused a .NET framework error and the SQL   Console to crash when clicking any monitored server.Diagnostic Manager

Dashboard

An issue preventing the Lock Waits and Tempdb panels from displaying in a customized Dashboard view no longer occurs.

Reports
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An issue preventing the Top Queries report to deploy correctly into a Microsoft Reporting Services Server no longer occurs.
This release fixes an issue where a custom report was deployed into the Microsoft Reporting Services Server instead of the selected report in
SQL   with a similar name.Diagnostic Manager

8.5 New features

Full support for SQL Server 2014

SQL   8.5 fully supports monitoring of SQL Server 2014 RTM. Users who implement the SQL Server 2014 In-Memory OLTP EngineDiagnostic Manager
functionality should note that SQL   does not support this feature at the moment.Diagnostic Manager

Hyper-V support

SQL   8.5 has extended virtual support to Hyper-V, providing users insight into the performance of their virtual system more effectively.Diagnostic Manager
Users can track and monitor Hyper-V specific performance metrics for a complete view of the virtualized server and the physical host. For additional
information, see .How SQLdm works with a virtual environment

Tech Preview of the new SQL Diagnostic Manager web console

In SQL   8.5 rapidly and easily identify problems. TheDiagnostic Manager   SQL Diagnostic Manager web console is designed to provide quick access to the
overall status of the SQL Server environment to help diagnose any issues.

Quickly view status of a single instance or instance groups.
Access from any connected browser. No SQL   Desktop Console required.Diagnostic Manager
Stand-alone web application with no need for IIS.
Provide an easy to use web console to non-DBAs without giving access to entire management console so they can check on status of their SQL
Server environment.

To provide feedback on the Tech Preview of the SQL   web console, access theDiagnostic Manager  .IDERA community forum

Monitoring and alerting enhancements

Enhanced alert response usability

Ability to set up Alert Response that is triggered only after multiple user defined metric thresholds have been breached. For additional information, see Conf
.igure automated responses to alerts

Inclusion filters for Query monitors

Ability to do query monitoring on selected applications, databases, and SQL text. For additional information, see .Configure advanced query monitor options

New filter in the Signature Mode and Statement Mode views

Ability to exclude data returned with null values through the  filter in the Signature Mode and Statement Mode views.Exclude Currently Running Queries

Improved Maintenance Mode flexibility

Additional monthly option for scheduling maintenance mode on monitored SQL server instances. For details, see .Schedule Maintenance Mode

Virtualization counters available for custom reports

Select both Hyper-V and VMware virtualization counters when creating a custom report. For additional information, see .Select counter type and counters

Run one-click System Diagnostics

Ability to run system diagnostics and collect service and desktop client logs in the System Diagnostics window. See  System Diagnostics for details.

Deadlock victim details now available in the Deadlock Sessions Report

The Deadlock Sessions Report of the  view includes deadlock victim information by default. Users no longer have to manually add thisSessions>Blocking
option through the  dialog. For additional information see, .Column Chooser Analyze blocked sessions

Configuration option added to control WMI timeouts

Configure the WMI timeout value in SQL   when suitable. For instructions, see .Diagnostic Manager Configure OS metrics monitoring

The SQLdm REST Service requires a service account that is a . If the service account provided during installation for the SQL local administrator
 services is not a local administrator, you need to manually change the service account in Windows Service ControlDiagnostic Manager

Manager.
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8.5 Fixed Issues

General

An issue causing settings in the Monitored SQL Server Properties window to revert no longer occurs.
This release fixes an issue in deadlock data collection that caused discrepancies in the UTCCollectionDateTime.
An issue causing SQL   to display an error on the monitored SQL Server 2014 instance when expanding the databases node,Diagnostic Manager
no longer occurs.
Some users may experience Windows console crashes, applying the  solves this issue. For additional information onMicrosoft update 2919355
this solution, see the Microsoft knowledge base articles:

Out of memory when you load some image resources in a Windows application.
Platform update for Windows 7 SP1 and Windows Server 2008 R2 SP1.

Alerts

An issue preventing cluster failover alerts to be triggered no longer occurs in SQL   8.5.Diagnostic Manager
An issue preventing SQL   to update statistics for some monitored SQL servers that triggered a persistent alert ‘Unable ToDiagnostic Manager
Monitor’ no longer occurs in version 8.5.

Reports

This release fixes an issue impeding the VM Statistics report to display correctly.
An issue preventing users from exporting the Blocking Sessions report in XML no longer occurs.
An issue preventing the CPU Statistics report to display correctly when being deployed to the Microsoft Reporting Services no longer occurs.

8.0.1 New features

There are no new features in this release.

8.0.1 Fixed issues

General

Users with large Repository databases no longer experience high CPU Usage by the sqlserv.exe process.
An issue causing occasionally negative CPU Delta (ms) and Physical I/O Delta values in the Details view of the SQL  Diagnostic Manager
Sessions tab, when parallel usage of CPU is enabled, no longer occurs.

Management Service Log

An issue causing exceptions in the SQLdm  Management Service logs when removing an availability group or replica from Availability Group
Topology no longer occurs.
The exceptions logged for ‘primary and foreign key duplication errors’ no longer occur.

AlwaysOn Availability Groups

An issue causing deadlock errors after updates to the AlwaysOn Availability Group Topology tables in SQL   no longer occurs.Diagnostic Manager

Mobile

Users who remain logged in the IDERA Newsfeed account and upgrade to SQL   8.0.1 no longer experience console crashes.Diagnostic Manager

8.0 New features

SQL Diagnostic Manager now fully supports the AlwaysOn Availability Groups feature of SQL Server 
2012

SQL   8.0 now allows DBAs to monitor their availability groups, availability replicas, and availability databases. Support for this featureDiagnostic Manager
comes with:

An  that allows you view the historical health of your availability groups, availability replicas, and availabilityAvailability Group Statistics report
databases.
An  that allows you to view the current topology of your availability groups configuration.Availability Group Topology report
Monitoring of key metrics specific to the AlwaysOn Availability Groups feature.
Queue Size and Transfer Rates charts.

For additional information on SQL   and the AlwaysOn Availability Groups feature, see .Diagnostic Manager Monitor AlwaysOn Availability Groups
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SQL Diagnostic Manager now offers integration with Microsoft System Center Operations Manager 
(SCOM)

SQL   8.0 now includes the SQLdm Management Pack (SQLdm MP) to enhance the SQL Server monitoring capabilities of MicrosoftDiagnostic Manager
System Center Operations Manager (SCOM). Detailed alert and status information tracked by SQL   provides SCOM with a wealth ofDiagnostic Manager
knowledge not previously available including:

Seamless integration between SQL   and the SCOM health model and console.Diagnostic Manager
More robust overview of your server health and performance through the addition of SQL   metrics to the current SCOM abilityDiagnostic Manager
to use availability to determine SQL Agent health.
Detailed record of state changes and events that might impact the availability and performance of your server.
Instant access to the SQL   Console from SCOM, providing access to vital insights not readily available using SCOM alone.Diagnostic Manager

For additional information about using SQL   with System Center Operations Manager, see Diagnostic Manager Integrate SQL Diagnostic Manager with
.SCOM

Change Log Summary report

The Change Log Summary report allows users to view a list of all actions and configuration changes performed in their SQL  Diagnostic Manager
environment over a specified period of time. For additional information on this report, see .Change Log Summary

Improved collection of query and non-query activities

SQL   8.0 now allows users to collect solely queries’ performance data through the  in the Monitored SQL ServerDiagnostic Manager Query Monitor tab
Properties window. Configure collection of non-query activities such as deadlocks and autogrow events through an independent window, the Activity

.Monitor tab

Blocked Process report available in SQL Diagnostic Manager

SQL   users are now able to view the captured Blocked Process report directly in their SQL   Console. In the ActivityDiagnostic Manager Diagnostic Manager
Monitor tab, users can configure the Blocked Process Threshold (in seconds) that results in the Blocking Process and Blocked Process details report. To
access this report, users can go to Sessions>Blocking and double click under Block Reports. For more information on this feature, see Set activity monitor

.options

Improved Maintenance Mode and Snooze Alerts features

In the SQL   8.0 version, applying maintenance mode modifications to a large number of servers at once is possible through theDiagnostic Manager
Maintenance Mode command. Review  for details. Also users that want to tackle several alerts, can mass snooze/resumeSchedule Maintenance Mode
alert generation through the Snooze Alerts/Resume Alerts commands. For additional information, see .Snooze Alerts

SQL Diagnostic Manager Console supports Operating Systems where FIPS compliance is required

The SQL   8.0 console supports operating systems with enabled system cryptography that use FIPS (Federal Information ProcessingDiagnostic Manager
Standard) complaint algorithms. For more information about , see the Microsoft document, .FIPS compliance FIPS Compliance

SQL Server 2014 experimental support

SQL Diagnostic Manager 8.0 is SQL Server 2014 compatible. This version of SQL Diagnostic Manager is not certified against newer builds of SQL Server
and should not be used with these builds in a production environment. IDERA provides experimental support while you use your installation in a testing
environment to ensure the features you rely on most are working as or better than expected.

Users who implement the SQL Server 2014 In-Memory OLTP Engine functionality should note that SQL Diagnostic Manager does not support this feature
at the moment.

8.0 Fixed Issues

General

An arithmetic overflow error that converts expression to data type integer in the Query Waits and Session Details views no longer occurs.
An issue causing errors related to data retention or data visibility in the History Browser no longer occurs. Note that some views in
SQL Diagnostic Manager only collect data on demand in the repository after configuration.
In SQL Diagnostic Manager 8.0 users are now able to limit the amount of memory used by the desktop client.

Servers

This release fixes an issue that occurred while refreshing the Server Summary view.

Databases

An issue causing errors related to fragmentation collector timeouts or fragmentation statistics collection in the Tables & Indexes view no longer occurs.
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Services

This release fixes an issue caused when the collector for the SQL Agent Jobs View could not interpret null values, resulting in job and job steps collection
errors.

Alerts

The transactions (Per Second) metric now displays correctly in the History Browser when user selects a historical snapshot.
This release fixes an issue where after modifying the advanced configuration settings of the SQL Server Status alert, the Lowered to OK status
still showed.

Resources

An issue causing an unknown value in the User/Schema column of the Procedure Cache view no longer occurs.

Reports

An issue preventing users from running the Alert History Report after deployment to Reporting Services no longer occurs.

7.5.4 New Features

General

Charts now properly manage real-time and scheduled collection data in the same time span

SQL Diagnostic Manager charts provide data whether collected real time or as part of a scheduled collection event. If you pause or leave this view and
then return during the same Console session, SQL Diagnostic Manager displays the real-time data points as previously viewed, followed by a period of
data points from any scheduled collections that occurred while you were away. For additional information about how SQL Diagnostic Manager displays
charts, see .Charts

Queries

Query Waits now located on Queries tab

The Query Waits feature is no longer located on the Resources tab but now is available on the Queries tab. For additional information about Query Waits,
see .View Query Waits

Alerts

Manage how the SQL Diagnostic Manager Console responds to alert notifications

SQL Diagnostic Manager can now play a sound when an event triggers an alert to change states. You can also control how SQL Diagnostic Manager
displays the resulting alert notification in the Console. For additional information about Console notifications for alerts, see .Configure notification settings

Set SQL Diagnostic Manager to notify you of only critical alerts

Use the Notifications section of the Console Options feature to set SQL Diagnostic Manager to notify you for only critical alerts. You can select whether
you want to view or even play a sound when a critical alert occurs. For additional information about Console notifications for alerts, see Configure

.notification settings

Mobile

SQLdm Mobile & IDERA Newsfeed now supports IIS 8

SQLdm Mobile & IDERA Newsfeed now supports IIS 8 on Windows 2012 and Windows 8 environments. For additional information about SQLdm Mobile &
IDERA Newsfeed requirements, see .SQLDM Mobile and IDERA Newsfeed requirements

7.5.4 Fixed Issues

General

SQL Diagnostic Manager now responds to the collection filtering set for disk drives to prevent the Collection service from gathering data on non-
monitored disks.
Users who upgraded to SQL Diagnostic Manager 7.5.3, and who collect data using a direct WMI connection no longer experience an issue
causing an instance to stop collecting snapshots.
An issue causing errors when the Collection service attempted to collect Table Growth information no longer occurs.
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Servers

SQL Diagnostic Manager no longer pauses data point creation in other real-time panels when the user accesses the Timeline view.
This release fixes an issue caused when the scheduled refresh did not successfully complete, resulting in missing History Browser snapshots.
The SQL Server Plan Cache object no longer continues to grow with SQL Diagnostic Manager queries even with the SQL Server Optimize for ad
hoc workloads server configuration option selected.
The SQL Diagnostic Manager Powershell plug-in now properly puts monitored SQL Server instances into maintenance mode when selected.

Alerts

The Autogrow alert no longer displays the same previous and current data file size when viewing alert details in the Alerts view.
SQL Diagnostic Manager no longer dismisses certain alerts when SQL Diagnostic Manager generates an Unable to Connect, Unable to Monitor,
or Paused alerts. These alerts include SQL Server Agent job alerts, VM Host Server Change, VM Resource Configuration Change, Mirroring
Server Role Change, and Cluster Failover alerts.
SQL Diagnostic Manager no longer displays an incorrect percentage in the Database Full (Percent) alert.
SQL Diagnostic Manager no longer delays generation of some Oldest Open Transaction alerts until the transaction is significantly older than the
alert threshold. The alert now triggers immediately when the transaction crosses the threshold.
An issue preventing some users from monitoring multiple instances and causing job completion error alerts no longer occurs.

Reports

The Server Summary report now correctly displays statistics graphs and grids even when the results include no data for that interval.
The Server Statistics report now consistently applies the UTC offset to both servers when using the report to compare two servers.

Counters/Custom Counters

When WMI counters are unavailable due to a stall, SQL Diagnostic Manager now continues to collect available counter data until it hits the
connection limit and triggers an alert.
VM custom counters now close the connection to the vCenter Server immediately after use, thereby avoiding a high number of connections to the
server at one time.

7.5.3 New Features

There are no new features for SQL Diagnostic Manager 7.5.3.

7.5.3 Fixed Issues

General

Users who upgrade to SQL Diagnostic Manager 7.5.2 no longer experience missed alerts.
Users who upgrade from SQL Diagnostic Manager 6.2 to a more recent version of SQL Diagnostic Manager no longer experience issues upon
subsequent upgrades. SQL  Diagnostic Manager displayed the message, "Query Monitor upgrade paused," in the log and caused excessive
connections to the Repository.
Users with large databases who upgrade to SQL Diagnostic Manager 7.5.2 no longer experience Management Service blockage, causing slow
inserts into the Repository.
SQL  Diagnostic Manager now successfully installs and no longer stalls on the splash screen while displaying the message, "Connecting to
Repository."
The SQLdm Management Service no longer causes high CPU on the Repository.

7.5.2 New Features

There are no new features for SQL Diagnostic Manager 7.5.2.

7.5.2 Fixed Issues

General

When upgrading to SQL Diagnostic Manager 7.5.x and a timeout occurs while upgrading the database statistics, SQL Diagnostic Manager now
properly re-submits the query and no longer indicates that it is running without re-starting the stopped upgrade. This issue caused some users to
not see older database information.
An issue causing the SQL Diagnostic Manager Console to take a long time to load or time out after upgrading to 7.5 and display the message,
"Unable to connect: Timeout expired attempting to open server connection," no longer occurs.
Users who upgrade to SQL Diagnostic Manager 7.5 no longer experience an issue causing the transaction log file to grow dramatically.
An issue with the stored procedure p_GetTagServersAsXML not closing or de-allocating a cursor no longer occurs as the stored procedure no
longer uses a cursor.
An issue with table statistics collection causing a communication problem between the Management Service and the Collection Service is
resolved.
SQLdm no longer displays an "Arithmetic overflow error" message when refreshing the Server Summary view This issue was caused by a
timestamp containing a value greater than the SQL Server Max Integer value.



Overview

An issue causing SQL Diagnostic Manager to display some monitored SQL Server instances more than once in the Servers tree no longer occurs.
The CPU Dashboard panel no longer displays an occasional red "X" in the Call Rates chart when the panel is resized.

Sessions

SQL  Diagnostic Manager no longer displays the messages, "Error executing Session List collector: Arithmetic overflow error converting
expression to data type int," or "Error processing Session List Collector: Object reference not set to an instance of an object," when some users
attempt to access pages in the Sessions view.

Resources

SQL Diagnostic Manager no longer displays the error message, "The given key was not present in the dictionary," when a user attempts to view
Server Waits.

Alerts

SQL Diagnostic Manager custom counters now properly trigger alert responses.
Deadlock and Autogrow alerts no longer persist after the triggering condition is resolved.

Reports

SQL Diagnostic Manager no longer displays the message, "Item with the same key has already been added," when some users attempt to run
the Top tables by Growth or Top Tables by Fragmentation report.
Users can now select the time of day in all SQL Diagnostic Manager reports by using the Start Hours and End Hours fields.

7.5.1 New Features

There are no new features for SQL Diagnostic Manager 7.5.1.

7.5.1 Fixed Issues

General

An issue causing an exception error and possibly preventing some users from closing the SQLdm desktop client no longer occurs.

Overview

The Memory, Network, and Virtualization panel chart selections are now properly saved when a user saves a Dashboard layout.
Timeline users who double-click an alert to access the Alerts pane with the selected alert highlighted now receive the proper selected alert
information in the Details pane of that view.

Sessions

On a case-sensitive server, the Sessions Blocking graph now shows the correct deadlocks in the sessions.

Resources

The Query Waits graphs right-click menu options View Text and View Query History are now operative.

Logs

A user interface update fixed an issue causing some Microsoft Windows 7 users to see a cut-off Search window in the Log tab.

Alerts

SQL Diagnostic Manager and the Windows Event Log now both show accurate metrics for the OS Disk Free Space (Size) alert.

Reports

Users who attempt to schedule email notifications for some reports no longer receive an error message at the end of the wizard.
Generation of the Top Databases report is improved, preventing the report from suffering a time out because of the long load time.
Disk Details report users no longer receive an exception message when attempting to run the report with the Drive Name field selection of All
Drives.

7.5 New Features



There are no new features for SQL Diagnostic Manager 7.5.

7.5 Fixed Issues

General

The SQL Diagnostic Manager installer no longer checks your Windows firewall service. If you have communication issues after installation, verify
that ports 5166 and 5167 are open for access in Windows firewall and/or whichever firewall you use.
SQL Diagnostic Manager now properly aggregates data based on the number of days displayed in the Aggregate query data into daily records
after X days field in the Grooming Options.
Users monitoring disk activity on Windows 2008 and later operating systems no longer have to wait one second per disk for statistics gathering.
Users no longer receive false "Unable to connect" alerts for monitored SQL Server instances known to be online. The server availability check
now attempts one connection retry in order to avoid alerting in case of transient network issues.
SQL Diagnostic Manager now can send email notifications to Gmail accounts and other email accounts using SSL encryption.
The About IDERA SQL Diagnostic Manager dialog box no longer includes the System Info button.

Virtual Machines

An issue in the SQLdm Management Service causing some VM statistics to not display for monitored virtual SQL Server instances no longer
occurs.

Dashboard

An issue causing the CPU Dashboard panel to display 0 when a greater value should appear no longer occurs. This issue was caused by
SQL Diagnostic Manager switching from one counter to another at certain refresh rates when calculating CPU values.

Server Overview

SQL Diagnostic Manager no longer attempts to delete a monitored SQL Server instance in some situations when the user pressed the Delete key
while in the Server view.
An issue causing some users to receive an exception error when attempting to view Server Details after quickly clicking through different panes of
the SQL Diagnostic Manager Management Console no longer occurs.

Sessions

The Y-axis unit of time measurement now appears in the Sessions > Locks Wait Time chart as "ms" (milliseconds).

Resources

Resources > Query Waits times are now in chronological order.
Users no longer receive the error message, "The given key was not present in the dictionary," when attempting to view the Resources > Server
Waits view.

Databases

SQL Diagnostic Manager no longer displays restore activity on the original database instead of the destination database. Now the destination
database includes any restore information.

Services

The SQL Agent Jobs list now retains the open (+) and closed (-) settings after a refresh. This list also remains on the same row after a refresh
and no longer jumps to the top of the list.
An issue causing the job collector to fail for some users no longer occurs. This issue occurred when the user attempted to filter jobs or job
categories with a string that included a single quote character (') in the title.

Alerts

The Alerts pane now retains your column sort selection when you return to the pane after visiting another page, as when investigating an
individual alert.
SQL Diagnostic Manager now sends an alert when a cluster failover occurs even when the server appears as offline in the preceding refresh of
the SQLdm Collection Service. Previously, this situation would not trigger a cluster failover alert.
The Session Tempdb Space Usage (MB) alert now triggers based on the Total User Space Used and no longer includes the Total Internal Space
Used in the calculation. This update fixes an issue where users received an alert that shows a tempdb session using more space than the entire
size of tempdb.
The Cluster Failover alert no longer displays a timestamp of 1-1-1900 when an event triggers an alert.
The Unsubscribed Transactions alert now displays the resulting time in hours, minutes, and seconds for easier comprehension.
This release fixes an issue that caused some users to receive alerts stating that the data files are over 1000.00% full.
Users no longer receive multiple email messages for the same alert.



Reports

Users no longer receive the error message, "An error occurred while retrieving data for this report. Additional information: Invalid Column name.
(Microsoft SQL Server, Error: 207)," when attempting to run a custom report.
An issue causing the Top Queries report to appear empty when the user selected a Custom Range older than seven days no longer occurs.

Custom Counters

An issue causing some users to receive an error message when attempting to modify an existing custom counter no longer occurs.

7.2.2 New Features

There are no new features for SQL Diagnostic Manager 7.2.2.

7.2.2 Fixed Issues

SQL Diagnostic Manager 7.2.2 now displays an accurate Physical I/O metric on the Blocking view of the Session tab.
SQL Diagnostic Manager 7.2.2 no longer displays XML document related error messages to users who upgrade to SQL Diagnostic Manager 7.2 
with a SQL 2005 repository. To learn more about the cause of this issue, see Microsoft Support Article 968914, "FIX: When you convert a TEXT 
column to a VARCHAR(MAX) column, an NTEXT column to a NVARCHAR(MAX) column, or an IMAGE column to a VARBINARY(MAX) column, 
the original NULL values in these columns may become empty strings in SQL Server 2005."
An issue causing some users to receive an error message when attempting to view details for a monitored SQL Server instance no longer occurs. 
When this issue occurred, the results were replaced by a large red X.
Both the Alerts and Custom Area views in SQLdm Mobile now display your custom counters regardless of whether you defined unique category 
names. By default, SQL Diagnostic Manager assigns the category “Custom” to all custom counters.

7.2.1 New Features

SQL Server 2012 RTM Support

SQL Diagnostic Manager 7.2.1 supports the use of SQL Server 2012 RTM version. Users who implement the SQL Server 2012 AlwaysOn 
functionality should note that while SQL Diagnostic Manager seamlessly monitors servers with this feature enabled, it does not currently administer 
or diagnose issues with AlwaysOn.

7.2.1 Fixed Issues

Users who have implemented SQL Diagnostic Manager 7.2 with SQL Server 2012 RC0 in a non-production environment may experience issues 
with data display on the Tempdb Summary and Database Files views after upgrading to SQL Diagnostic Manager 7.2.1. Upgrading to SQL Server 
2012 RTM their test environment will remedy this issue.
SQL Diagnostic Manager 7.2.1 no longer displays error messages related to an "XML document" when users who upgraded to SQLdm 7.2 
attempt to access the SQLdm Management Console.
Users who implemented SQL Diagnostic Manager 7.2 with SQL Server 2012 RC0 in a non-production environment now receive an accurate 
name and version number for SQL Server 2012 RTM when viewing the Compatibility Level for a monitored SQL Server 2012 RTM instance.

7.2 New Features

Monitoring SQL Server virtual environments

Get complete insight into the performance of your virtualized SQL Server databases. Monitor and track VMware-specific performance counters 
allowing you to get a complete performance picture of the SQL Server environment. Two VM-related reports provide performance trends and a 
summary of your virtualized environment. For additional information about configuring the new VM functionality, see Configure your virtual machine 

.connections

SQL Server 2012 experimental support

SQL Diagnostic Manager 7.2 is SQL Server 2012 RC0 compatible. This version of SQL Diagnostic Manager is not certified against newer builds of 
SQL Server and should not be used with these builds in a production environment. IDERA provides experimental support while you use your 
installation in a testing environment to ensure the features you rely on most are working as or better than expected.

Users who implement the SQL Server 2012 AlwaysOn functionality should note that while SQL Diagnostic Manager seamlessly monitors servers 
with this feature enabled, it does not currently administer or diagnose issues with AlwaysOn. For additional information about SQL Diagnostic 
Manager and SQL Server 2012, see .SQL Diagnostic Manager requirements

SQLdm Mobile views

SQLdm Mobile features a new server dashboard specifically for tablets and incorporated VMware monitoring data. For additional information about 
the new SQLdm Mobile features, see SQLdm Mobile Help.
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Reporting on Tempdb Statistics

You can now run the Tempdb Statistics report to quickly identify and keep tabs on tempdb performance-related issues. For additional information 
about the new tempdb report, see .Tempdb Statistics report

SQL Server Memory Usage Percent counter available for custom reports

You can now select the SQL Server Memory Usage Percent counter when creating a custom report. For additional information about creating a 
custom report, see .Custom reports

Updated alert notification functionality

SQL Diagnostic Manager now allows you to suppress system tray notifications when a monitored SQL Server instance returns to an OK status. 
Click Tools > Console Options. On the Notifications tab, check the Never show console alert notifications when the server status goes to OK 
checkbox, and then click OK. For additional information about the Management Console options, see .Configure Console Options

CPU Statistics report now available in a custom range of hours

The CPU Statistics report now includes an option for you to select a custom date range and view results in hours. To select this range, click Reports 
> CPU Statistics. Select the appropriate monitored SQL Server instance, and then select Custom Range from the Period drop-down list. Use the 
calendar tool to select the range, and then click OK. Select Hours from the Sample drop-down list to view your results in hours. For additional 
information about the CPU Statistics report, see .CPU Statistics report

Input how long SQL Diagnostic Manager waits before raising an alert for a long-running job

Users can now specify a minimum job length for the SQL Server Agent Long Running Job (Percent) alert. This may be used to prevent alerting on 
short or trivial jobs. For additional information about configuring job exclusions, see .Configure Job Exclusions

7.2 Fixed Issues

Users with a large number of databases no longer notice a performance issue caused by leaving the SQL Diagnostic Manager Dashboard open 
for a long period of time.
The Value Configuration window in SQL Diagnostic Manager no longer displays blank column headings but includes alert state icons to easily 
identify the content. You can access the Value Configuration window by clicking Edit on the Alert Configuration window.
The Login Time column of the Sessions Details page now uses the local time on the client server for the timestamp. You can access the Sessions 
Details page by clicking Sessions > Details while viewing a monitored SQL Server instance.
SQL Diagnostic Manager no longer displays an error message when a user attempts to view tempdb detail for a SQL Server 2000 monitored 
instance. Tempdb monitoring is supported for SQL Server 2005 and above monitored instances only.
Table growth collection no longer fails for monitored SQL Server 2000 servers, allowing the Top Table Growth report to function correctly.
SQL Diagnostic Manager no longer displays an error message when a user attempts to use PowerShell cmdlets to configure Query Monitor.
The CLR Enabled alert now properly functions after triggering an Informational alert.
The Export to Excel function on the Tempdb Sessions view no longer fails for users who had cells in the Last Command column containing more 
that 32,767 characters.
The Database Statistics report results format is updated and no longer causes any issues in viewing accurate results for users with large 
databases.
SQL Diagnostic Manager no longer displays and error message when a user attempts to schedule an email delivery of the Top Tables by 
Fragmentation report.
The Repository now properly saves Query Monitor data while the grooming job runs.
A failure in the SQL Diagnostic Manager replication monitoring no longer prevents otherwise successful scheduled refreshes from saving to the 
repository.
The Table Fragmentation (Percent) alert now changes to gray shading if the alert is raised for more than 12 hours.
Extremely long queries no longer cause the Query Monitor to generate OutOfMemory exceptions on the Collection Service. These exceptions 
could previously cause a service crash.
Users no longer experience an error during installation that caused an error when attempting to validate the user account used to perform the 
install.
Performance updates including query aggregation and grooming changes improve SQL Diagnostic Manager data collection and processing 
efficiency.
SQL Server authentication no longer occasionally fails for users attempting to use a password containing the quotation mark (") special character.
When you delete a database, the system is groomed to removes all references to that database. Now the feature also grooms the deleted 
database from the [SQLServerDatabaseNames] table.

7.1.1 New Features

There are no new features for SQL Diagnostic Manager 7.1.1.

7.1.1 Fixed Issues

Improvements now allow SQL Diagnostic Manager to return data for the Session Details page more quickly and avoid a timeout due to slow or no 
response.

7.1 New Features
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New SQL Server dashboard

SQL Diagnostic Manager now features a completely redesigned dashboard, which dramatically expands the display of your performance data and 
simplifies the view of the overall health of a SQL Server instance. For additional information about the new dashboard, see the SQL Server 

.performance overview

New Tempdb monitoring

You can now quickly identify and resolve tempdb performance-related issues with the new tempdb monitoring and diagnostic views. For additional 
information about the new tempdb monitoring functionality, see .tempdb status summary

New SQLdm Mobile views

The following new views in SQLdm Mobile make diagnosing performance issues even easier while you're on the go:

Blocking Chain View
Sessions > Top Wait Customer View
Tempdb Monitoring View

For additional information about SQLdm Mobile, see SQLdm Mobile Help.

View and copy SQL Agent Job messages from the Job History list

SQL Diagnostic Manager now allows users to view SQL Agent Job messages from the Job History list. Right-click the appropriate job, and then 
select View Message. A copy feature allows you to copy the existing message and then paste it into a different application. For more information 
about SQL Agent jobs, see how to .Monitor SQL Agent Jobs

7.1 Fixed Issues

SQL Diagnostic Manager Repository timeouts no longer cause the SQL Diagnostic Manager services to stop for some users.
This release of SQL Diagnostic Manager fixes an issue that caused SQL Diagnostic Manager to display an error message when some users
attempted to configure alerts.
SQL Diagnostic Manager performance improvements decrease the amount of time spent waiting for page loading and processes to complete.
The CLR Enabled alert now properly retains settings when the user changes the alert state to Informational.
SQL Diagnostic Manager no longer experiences an issue when a user adds servers to a custom view.
Improved collection functionality corrects an issue causing some users to see an incorrect SQL CPU Usage statistic.
Refreshing the SQL Agent Jobs view no longer deselects all selected rows.
The SQLdm Service Availability chart on the Services tab no longer incorrectly displays, "Unable to monitor" when the server is available.
SQL Diagnostic Manager no longer displays an error message when users who upgrade to SQL Diagnostic Manager 7.0 attempt to edit their
custom counters.
SQL Diagnostic Manager no longer displays the error message, "An INSERT EXEC statement cannot be nested," for some users who attempt to
run a report when SQLdm Application Security is enabled.
SQL Diagnostic Manager users monitoring SQL Server instances by IP address instead of name no longer receive the error message, "The
server you are trying to access is not monitored by IDERA SQL Diagnostic Manager," when attempting to view history for a mirrored database.
Users who have clustered servers no longer receive the error message, "Error interpreting Services Collector: Invalid length parameter passed to
the substring function" when attempting to use the Show Real Time View function.

7.0 New Features

New SQLdm Mobile interface

SQL Diagnostic Manager now offers a Web application (SQLdm Mobile) that displays real-time SQL Server performance dashboards on a variety of 
mobile devices, including iPhone, iPad, Android and Blackberry. SQLdm Mobile includes the IDERA Newsfeed technology. The IDERA Newsfeed is 
a revolutionary new way for DBAs and managers to collaborate, share knowledge, and keep close tabs on their most critical SQL Server issues.

New Alert Templates

SQL Diagnostic Manager now offers alert templates, which allow a user to configure generic alert settings to apply to monitored SQL Servers or 
groups of servers all at once. You can create and assign alert templates to any of your monitored SQL server instances.

New Informational Alerts

Informational alerts allow you to set a threshold that triggers a status that does not affect the overall status of the server within SQL Diagnostic 
Manager. You can use informational alerts to notify an administrator of the state of a particular metric for a server or trigger secondary processes 
that could take action to prevent issue escalation.

Improved Alert Response Usability

Alert Response rules, which configure how SQL Diagnostic Manager responds when an event triggers an alert, are easier to create and manage 
due to an updated interface and process. Users can now apply an alert response rule to all metrics quickly and easily.

https://wiki.idera.com/display/SQLDM101/Get+the+SQL+Server+performance+overview
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Improved Notification Times for Unresponsive SQL Server Instances

SQL Diagnostic Manager can now alert you more quickly when one of your monitored SQL Server instances becomes unresponsive for any reason. 
Although the default is set to 30 seconds, you can adjust the interval at which the Collection Service checks whether your SQL Server instances are 
“up” or available. If a connection is not confirmed within the specified time, SQL Diagnostic Manager creates an Unable to Connect alert.

Improved Metrics Collection

The Collection Service now:

Uses a different SQL Server metric to determine the CPU Busy Value for instances running SQL Server 2005 or later. This change
prevents timeout errors during the metric collection process.
Uses separate processes to collect table growth and fragmentation metrics. This approach ensures quiet time data collection does not
delay alerts about other metric thresholds.
Is able to efficiently collect error log metrics for SQL logs that are large or infrequently cycled.

Improved Repository Performance

The SQL Diagnostic Manager Repository database will perform more efficiently due to the following enhancements:

The Repository grooming job now:
Calls the index maintenance in a separate step. Using SQL Server Management Studio, you can now disable this step and then
later run your own index maintenance script after the grooming job completes.
Better handles I/O and CPU demands when processing data.

Several stored procedures used by SQL Diagnostic Manager Repository were updated.

New Reports

SQL Diagnostic Manager now offers the following new reports:

The Metric Thresholds report is for users who want to view a list of metric thresholds for a monitored SQL Server instance. The report
includes the metric name, description, and threshold for their informational, warning, and critical alerts.
The Disk Details report lists key disk metrics for a specific SQL Server instance. This report offers Disk Time Per Read, Disk time Per
Transfer, Disk Time Per Write, Disk Reads Per Second, Disk Transfers Per Second, and Disk Writes Per Second.

7.0 Fixed Issues

Alerting Updates

SQL Diagnostic Manager now offers the following updates to alerting:

SQL Diagnostic Manager now accesses the correct database when a user double-clicks an associated Fragmentation alert on the Active
Alerts tab of the SQLdm Today page. When you use this feature, SQL Diagnostic Manager displays the affected database information
on the Tables & Indexes pane of the Databases tab.
Editing an alert response no longer causes SQL  Diagnostic Manager to display an error message when attempting to save your
changes. This issue affected users who manually changed XML detail in the repository, and then attempted to save additional alert
response changes using the SQL Diagnostic Manager Console.
SQL Diagnostic Manager now properly captures customer error detail when Error: 0, Severity: 19, State: 0 occurs. This issue affected
users using the SQL Server error log alert.
The SQL Diagnostic Manager scheduled alert refresh is no longer dependent on table statistics before completing a full refresh and
possibly triggering alerts. Because table growth and fragmentation can be long-running processes, SQL  Diagnostic Manager was
delayed in delivering alerts. These items were removed from the scheduled alert refresh for a more responsive alert system.
SQL Diagnostic Manager now raises an alert when a monitored SQL Server instance does not respond within the default 30 seconds.
You can configure the response time in the Server Properties.
SQL Diagnostic Manager now checks to make sure that the WMI services are running before trying to connect to a monitored SQL
Server instance. If SQL Diagnostic Manager detects that previous attempts to connect are causing multiple connections, it will stop
monitoring that server and triggers an alert. All real time views in SQL Diagnostic Manager will display an error message explaining the
issue. SQL  Diagnostic Manager automatically resumes monitoring once the number of connections drops below the default of 30
connections.

Fragmentation Monitoring Updates

SQLdm now offers the following updates to your table fragmentation monitoring:

SQLdm now accurately collects table fragmentation data on tables within the entered size range. An issue causing SQLdm to collect 
table fragmentation data on tables less than the entered minimum size no longer occurs.
Large tables no longer cause a block when collecting table fragmentation on a monitored SQL Server instance. This issue occurred 
when multiple very large tables were involved. Fragmentation data for populating the reorganization panel on all tables in a database is 
not collected. The reorganization query in SQLdm 6.1 and SQLdm 6.2 can timeout before table statistics are collected. For more 
information, refer to IDERA Solution 1583.

SQL Server Statistics Updates



SQL Diagnostic Manager now offers the following updates to the functionality that collects and analyzes your SQL Server statistics:

The Sessions view now retains any custom filtering when viewing your Historical Snapshots. Custom filtering across all snapshots helps 
you quickly determine changes needing your attention.
The History Browser on the Queries tab now allows you to scroll when you have large amounts of data.
The SQL Server Physical I/O chart on the Resources tab now displays values in seconds instead of raw values. Displaying results in 
seconds provides you with more accurate real-time analysis.
Users with mirrored databases no longer receive an error message that the mirror is not monitored when the database is actually 
monitored. This issue affected users viewing their monitored mirrored database information in the real time view on the Mirroring pane of 
the Databases tab.
SQL Diagnostic Manager now includes a new counter for collecting CPU stats. This new counter include a number of improvements over 
the previous counter, which occasionally suffered an error due to reaching maximum capacity cumulative CPU time.
SQL Diagnostic Manager no longer displays an error message when a user stops the Session Detail Trace and then refreshes the view. 
Previously, users received the error message, "Error starting Session Details collector System.InvalidOperationException: 
BeginExecuteReader: CommandText property has not been initialized."
Users with very large numbers of tables no longer cause the CPU to reach maximum threshold during table statistics collection. New 
processes allow SQL Diagnostic Manager to read large data sets in smaller chunks to avoid collecting unnecessary data and causing a 
strain on CPU resources.
Users working on diagnostics while troubleshooting can now add a configuration file entry to limit the procedure cache row count. The 
new key is maxRowCountProcedureCache, which has a default value of 10000.
This release includes improvements to the repository grooming process, which fixes grooming of the ServerActivity table and resolves an 
issue causing occasional deadlocks during grooming.

Reporting Updates

SQL Diagnostic Manager now offers the following updates to reporting:

Unauthorized users can no longer access data for restricted SQL Server instances when viewing a report through SQL Server Reporting 
Services. This issue affected all users who restrict access to specific instances using Application Security features. This update improves 
data security and prevents confusion when a user unwittingly views data for the wrong instance.
Users can now select up to 10 Windows, SQL Server, and/or custom counters when creating a custom report. These additional counters 
provide more flexibility and detail in your reports.
If a custom counter contains special characters (<>%-), then your custom report generation fails with the error: Field names must be 
CLS-compliant identifiers. A CLS-compliant Custom Counter name uses the following rule: the first character of an identifier can be an 
uppercase or lowercase, titlecase, modifier, or other letter, or letter number. The subsequent characters can be any of the previously-
mentioned characters, plus non-spacing or spacing combining marks, decimal numbers, connector punctuation, and formatting codes.
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